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Clic proteins influence ethanol-related behavior in flies and other species and also 

mediate TGF-β signaling. These findings suggest that Clics and the TGF-β signaling 

pathway might work together to modulate behavioral responses to ethanol. I used the 

Drosophila model to address the hypothesis that TGF-β signaling is important for 

ethanol sensitivity. Ethanol sensitivity was blunted by multiple transposon insertions in 

the TGF-β receptor gene thickveins. Collectively, however, I found no consistent 

correlation between expression of thickveins and altered ethanol sensitivity in flies 

harboring transposons. I therefore also assessed ethanol sensitivity in flies with loss of 

function point mutations in thickveins. Ethanol sensitivity was not altered in these 

additional thickveins genotypes, contrary to my major hypothesis. My analysis of 
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thickveins suggests that TGF-β signaling might influence ethanol sensitivity, but if so 

there must be a complex relationship between the function of this pathway and 

sensitivity to alcohol.   
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INTRODUCTION 

 
 
 
 

Alcohol Abuse 

Alcohol is a legal drug that has a depressant effect on the central nervous 

system. Consumption of alcohol results in an initial elated feeling, but drinkers might 

also experience reasoning impairment, sedation and slowed motor functions as well as 

slurred speech as they become increasingly intoxicated. It is estimated that over 90% of 

adults in America have had at least one encounter with alcohol consumption and that 

44% of adults in America are drinkers (consume more than 12 drinks per year) (DHHS, 

2000). Beyond the general social acceptance, people likely consume alcohol for other 

perceived benefits such as stress relief. However, the negative impact alcohol has on a 

person’s health far outweigh the benefits. On a physiological level, it is well documented 

that moderate to heavy drinking can lead to liver cirrhosis, cancer, and high blood 

pressure leading to stroke and heart attack (DHHS, 2000). Furthermore, heavy drinking 

can lead to alcohol abuse, dependence and other mental health disorders associated 

with increased consumption of alcohol. 

 A person is considered an alcohol abuser when they drink excessively despite 

role impairment and other social issues (APA, 2000). If not treated, alcohol abuse can 

morph into alcohol dependence marked by the development of tolerance to alcohol and 

withdrawal symptoms when trying to quit (APA, 2000). Approximately 7.4% of adults 
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who consume alcohol in the United States are alcohol abusers or alcoholics (APA, 

2000). The costs of alcohol abuse are staggering with hundreds of  billions of dollars 

spent annually in the U.S. on effects of alcohol abuse (DHHS, 2000). However there are 

few effective treatments to combat alcohol abuse and none that address the underlying 

causes of the disease. 

Alcohol abuse is considered a complex disease with both environmental and 

genetic components. While there is an environmental aspect, 50-60% of risk variance is 

thought to come from genetics (APA, 2000). The genetic component of this disease is 

also complex with what is thought to be a polygenic mode of inheritance with many 

genes of small effect size. In a longitudinal genetic study done by Schuckit (1994) 

evidence was found that men who were at risk of developing alcohol abuse due to a 

family history of alcohol abuse or dependence had a lower level of response to alcohol. 

That is to say that these men did not become intoxicated at the same doses as men 

without family histories for alcohol abuse. This has led to the development of the theory 

that if an individual is initially less sensitive to alcohol (i.e. has decreased level of 

response to alcohol) then that individual is at greater risk for developing alcohol abuse 

tendencies (Schuckit, 1994). The identification of this inverse relationship between 

sensitivity to alcohol and alcohol abuse has led to further genetic studies such as this 

one and different preventative techniques. 

Ethanol has a wide variety of  targets throughout the human body resulting in the 

biological and behavioral effects seen upon consumption of alcohol. The nervous 

system is the main target of these effects with GABA-A receptors, NMDA receptors, and 

nicotinic acetylcholin receptors (nAChR) being some of the more well characterized 
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targets of ethanol (Spanagel, 2009). Recent studies have implicated cAMP (Moore et 

al., 1998), as well as GABA receptor genes (Dzitoyeva et al., 2003; Paul, 2006) and 

other genes such as Chloride Intracellular Channel (Clic) (Bhandari et al., 2012) in 

alcohol sensitivity. While there is strong evidence to support these genes being involved 

in the genetic pathways that impinge on alcohol sensitivity, these studies by no means 

have identified all the genes that are involved. The limited data on the biological 

pathways involved as well as the lack of effective treatment available provide the 

rationale for additional studies to uncover the genetic pathways involved in the 

behavioral responses to alcohol. 

 

Drosophila as a Model  

 Drosophila melanogaster is a well-established genetic invertebrate model. It has 

been utilized in many studies on abused substances including alcohol. While it is an 

invertebrate species, it exhibits many of the same behavioral responses to alcohol as do 

mammals. An initial exposure to low levels of ethanol results in a hyperactive behavior 

in the fly, which is also observed in other species (Guarnieri and Heberlein, 2003). 

Higher concentrations of ethanol and longer exposures to ethanol result in the loss of 

postural control and sedation (Guarnieri and Heberlein, 2003). Repeated exposures to 

ethanol can lead to the development of tolerance similar to that observed in vertebrates 

(Scholz et al., 2000; Guarnieri and Heberlein, 2003; Mackay and Anholt, 2006). This 

behavioral conservation makes Drosophila an excellent tool for modeling responses to 

alcohol.  
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 Many assays have been developed to measure acute ethanol sensitivity in 

Drosophila. The Grotewiel lab developed an assay called ethanol Rapid Iterative 

Negative Geotaxis (eRING) that combined startle-induced climbing and ethanol 

exposure to measure the sedative effects of ethanol on negative geotaxis (Bhandari et 

al., 2009). I used this assay extensively to examine acute ethanol sensitivity. More 

details on eRING can be found in Chapter 1. 

 In addition to behavioral conservation, there is also significant genetic 

conservation between Drosophila and other species. Approximately 2/3 of all human 

disease genes are represented by obvious orthologs in Drosophila (Mackay and Anholt, 

2006). Because of the genetic conservation observed, there is also conservation of 

biological pathways controlled by those genetics. The conservation observed on a 

molecular level in Drosophila allows for the powerful genetic analysis of pathways 

important in biology and disease. This conservation in Drosophila applies well to genes 

involved in ethanol sensitivity. For example, several genetic pathways such as those 

involving neuropeptide F, cAMP, and GABA receptors have been identified and well 

characterized as being involved in ethanol sensitivity in Drosophila  and other species 

(Rodan and Rothenfluh, 2010). 

 Drosophila are an advantageous model in other regards as well. Primarily, they 

are a cost effective model compared to other models such as mice. Additionally, their 

quick generation time (about 2 weeks) allows for quick propagation of offspring for 

experimentation. Their strongest advantage is the availability of many genetic reagents. 

Finally, as mentioned above, their behaviors are easily observed and assessed which is 

beneficial for this study. 
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Chloride intracellular channel and ethanol behavior 

 Chloride intracellular channels (CLICs) constitute a family of proteins with 

possible functions as chloride channels, regulators of TGF-β signaling and other 

biochemical processes. In mammals there are 6 CLIC (CLIC1-6) proteins, 2 in worms, 

and one in flies (Bhandari et al., 2012). The fly Clic protein has significant homology to  

Clic4 and other Clic proteins protein in mammals.  

 While the predicted function of CLIC as a channel protein is somewhat 

controversial, other studies have suggested additional functions of CLICs in other 

biological processes. These additional functions of CLIC include interactions with 

ryanodine receptors (Jalilian et al., 2008), 14-3-3 proteins (Suginta et al., 2001), binding 

to A-kinase anchoring proteins (AKAP) (Shanks et al., 2002) and involvement in the 

TGF-β signaling pathway (Shukla et al., 2009). Most recently a study across species 

identified CLIC as having a role in sensitivity to alcohol (Bhandari et al., 2012). Bhandari 

et al (2012) found that ethanol sensitivity was decreased in flies with attenuated Clic 

function and  that worms with loss of the two Clic genes had blunted sensitivity to 

ethanol as well as enhanced acute functional tolerance. Further they found that ectopic 

expression of Clic4 had blunted ethanol induced ataxia (Bhandari et al., 2012).  These 

studies strongly suggest that the Clic family of genes plays a conserved role in ethanol 

sensitivity, although they do not address potential molecular mechanisms of Clic action. 

Interestingly, Shukla et al. (2009) showed that vertebrate CLIC4 functions in the 

Transforming Growth Factor Beta (TGF-β) signaling pathway by assisting in SMAD 

transcription factor function. Thus, it is possible that fly Clic also functions in this 
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pathway and therefore that TGF-β signaling might be an important regulator of ethanol 

sensitivity. 

 

TGF-β Signaling 

 TGF-β signaling has been implicated in a wide range of biological processes 

including growth, cell differentiation, adhesion and cell death (Massague, 1998). In 

Drosophila most studies on TGF-β signaling have focused on the larval neuromuscular 

junction (NMJ) during development. Its role in the NMJ has been found to assist in 

synapse development and function (Keshishian and Kim, 2004).  

 TGF-β signal transduction occurs in response to binding of a TGF-β ligand. In 

vertebrates as well as in invertebrates there are several different classes of ligands that 

have different functions depending on developmental timing and tissue (Massague, 

1998). In Drosophila, there are two primary classes of ligands, Bone Morphogenetic 

Protein (BMP) and Activin. In the BMP class are the specific ligands decapentaplegic, 

screw and glass bottom boat which all participate in retrograde signaling at the NMJ 

(from muscle to presynaptic receptor) (McCabe et al., 2003; Keshishian and Kim, 2004; 

Gesualdi and Haerry, 2007; Bayat et al., 2011). The Activin class of TGF-β ligands 

includes Drosophila Activin, maverick, dawdle, and myoglianin which participate in 

anterograde signaling (neuron to post synaptic muscle receptor) (Gesualdi and Haerry, 

2007; Bayat et al., 2011).  

 Ligands present in high enough quantities will dimerize and bind to their 

appropriate receptor complexes. Receptor complexes are the result of association of 

two Type I and two Type II transmembrane serine/threonine kinase receptors. In 

6 
 



www.manaraa.com

Drosophila, the Type I receptors are thickveins (TKV), baboon (BABO), and Saxophone 

(SAX) and the Type II receptors are wishful-thinking (WIT) and punt (PUT). Of these 

receptors, there is evidence that BMP ligands bind to the TKV, SAX, PUT and WIT 

receptor complexes on the neuron (Marques et al., 2002; McCabe et al., 2003; 

Keshishian and Kim, 2004) and the Activin ligands bind to BABO and PUT receptor 

complexes on the muscle (Figure 1) (Marques et al., 2002; Lee-Hoeflich et al., 2005).  

 Upon ligand binding (specifically the ligand binds to the type I receptors), the 

kinase function becomes activated by the cross phosphorylation of the cytoplasmic 

domains of the receptors (Type II receptors phosphorylate the Type I receptors which in 

turn phosphorylate the Type II receptors) (Massague, 1998). Once activated the Type I 

receptors are able to phosphorylate a series of downstream SMAD proteins in the 

cytoplasm. The SMAD phosphorylated by TKV and SAX in Drosophila is Mothers 

against decapentaplegic which is an R-SMAD (aka receptor-regulated SMAD) 

(Keshishian and Kim, 2004) (Figure 1). The SMADs phosphorylated by BABO is simply 

called dSMAD (aka Drosophila SMAD) (Keshishian and Kim, 2004) (Figure 1). Once 

SMADs are phosphorylated they participate in signal transduction by binding with a Co-

SMAD and translocating into the nucleus where they are then able to bind to DNA and 

act as transcription factors. Vertebrate CLIC4 functions in the TGF-β signaling pathway 

by binding to a molecule called Schnurri-2 once the pathway has been activated 

(Shukla et al., 2009). Together, CLIC4 and Schnurri-2 translocate to the nucleus and 

once there dissociate. CLIC4 is then able to bind with SMADs in the nucleus and act 

with them as a transcription factor complex (Shukla et al., 2009). 
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Figure 1. TGF-β Signaling in the Drosophila Neuromuscular Junction.  Adapted 

from Bayat et. al, 2012.  

 

 

 

 

 

 

 

8 
 



www.manaraa.com

Aim of this Thesis 

 The global hypothesis for this study is that TGF-β receptors influence acute 

sensitivity to ethanol. Therefore the primary aim of this thesis is to characterize the 

TGF-β receptor gene tkv in Drosophila ethanol sensitivity.  Additionally, I performed a 

preliminary genetic analysis of two additional TGF-β receptor genes, babo and wit, in 

ethanol sensitivity. To address these aims, I molecularly characterized several 

transposon insertions in the TGF-β receptor genes and then assessed the effects of the 

transposon insertions on gene expression.  Additionally, I assessed ethanol sensitivity 

in tkv, wit and babo transposon insertion lines and explored whether previously 

characterized point mutations in tkv or RNAi-mediated knock-down of this gene altered 

ethanol sensitivity.  Finally, I also determined whether internal alcohol concentrations 

were altered in tkv transposon strains. The global prediction from my major hypothesis 

is that mutations that disrupt the normal transcription and function of these TGF-β 

receptor genes will blunt acute ethanol sensitivity. 
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CHAPTER 1 

Materials and Methods 
 
 
 
 

*Detailed protocols can be found in the Appendix. 

 

1.1 Fly Husbandry, Fly Strains, and Genetics 

Flies were reared on standard Drosophila medium (10% sucrose, 2% yeast, 3.3% 

cornmeal, 1% agar, 0.2% Tegosept) supplemented with active yeast at 60% relative 

humidity and 25◦C under a 12-hour light/dark cycle. All flies carrying thickveins (tkv), 

wishful-thinking (wit) and baboon (babo) transposons (Table 1) were backcrossed for 

seven generations to w[A] (the laboratory’s standard stock containing the w1118 allele) 

by selecting for the w+ eye color marker in the transposons (Thomas and Grotewiel, 

unpublished). Homozygous lethal tkv mutant chromosomes were maintained in trans to 

the CyO balancer chromosome.  tkv7 and tkv8 (Table 1), previously characterized point 

mutations at two different locations in tkv, were moved into the w[A] genetic background 

by backcrossing for 7 generations to d07811 homozygous transposon insertion flies that 

had been previously backcrossed to w[A] as described above.  tkv7 and tkv8 were 

tracked through the backcross by selecting for tkv7/d07811 or tkv8/d07811 based on eye 

color. 
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Table 1. TGF-β Receptor Genetic Manipulations. Each allele was backcrossed to w1118 for seven generations. 
Gene   Allele   Class  Location  Confirmed?  Source   Viability 

thickveins  d07811  P-element transposon  2L:5237460 yes Harvard/L. Thomas  homozygous viable
        
        
        
  
      
          
       
           
        

    
      

    
       

        
      

         
       
         
        

        
      

         
       
          

     
f02766

 
PBac transposon
 

2L:5221749 yes  Harvard/L. Thomas 
 

homozygous viable
  

 KG05071
 

 P-element transposon
 

  2L:5259281
 

  no
 

 Bloomington/L. Thomas
 

homozygous lethal 
  

c06013
 

PBac transposon
 

2L:5237496 yes
 

 Harvard/L. Thomas 
 

homozygous lethal
  

f03305
 

PBac transposon 
 

2L:5234131 yes  Harvard/L.Thomas
 

homozygous lethal
  

  8 
 

 LOF point mutation 
 

 
2L:5221353 

(C>A) 
 

yes
 

 Bloomington 
 

homozygous lethal
  

  7 
 

 LOF point mutation 
 

 
2L: 5220203 

(G>A) yes
 

 Bloomington 
 

homozygous lethal
  

wit 
 

d02492
 

P-element transposon
 

3L:4071839 yes
 

 Harvard/L. Thomas 
 

homozygous viable
  

e01243
 

PBac transposon
 

3L:4071615 yes
 

 Harvard/L. Thomas 
 

homozygous viable
  

e00566
 

PBac transposon
 

3L:4064700 yes  Harvard/L. Thomas 
 

homozygous viable
  

baboon 
 

k16912
 

P-element
 

2R:4840513 yes
 

 Bloomington/L. Thomas
 

homozygous lethal
  

c050710
 

 PBac transposon
 

2R:4841108 yes
 

 Harvard/L. Thomas 
 

homozygous lethal
  

c04236 PBac transposon 2R:4846414 yes  Harvard/L. Thomas homozygous lethal
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All UAS lines used in RNAi experiments were in the Vienna Drosophila Research 

Center (VDRC) standard background containing a w1118 mutation (Table 2). Gal4 lines, 

Mef2 Gal4 and Actin/CyO- were backcrossed to w[A] for seven generations as above 

(Thomas and Grotewiel, unpublished). To control for genetic background, progeny from 

Gal4 flies crossed to w[VDRC] and UAS flies crossed to w[A] were used for eRING 

experiments. 

Table 2. UAS-RNAi and GAL4 Lines. UAS lines were in the 
w[VDRC] background  and GAL4 lines were backcrossed to 
w1118. 

Allele   IR Target Site     Viability 

3059  5221k-5221.2k  
::actin-
Gal4  viable 

       

    
::mef2-
Gal4  viable 

       

105834  5219.8k-5220.3k  
::actin-
Gal4  viable 

       

    
::mef2-
Gal4  

adult 
lethal 

            
             

 

1.2 Transposon Insertion Confirmation 

All transposon insertions were confirmed prior to and after backcrossing. Flies 

were collected under anesthesia (CO2) and then killed by freezing at -20◦C. Genomic 

DNA was isolated using a revised version of the QiagenTM DNAeasy Blood and Tissue 

(250) kit. Confirmation of transposon insertions was carried out via standard PCR with 

200ng of genomic DNA and primers specific to each transposon insertion location 

(Table 3). PCR reactions were electrophoresed on 1% agarose gels and visualized by 

ethidium bromide staining. 

12 
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Table 3. PCR primers for Allele Confirmation. Primers used to confirm location of transposon 
insertions and point mutations. 

Gene Allele    Primer 
ID  Primer Sequence 

Thickveins d07811   MSG86   5'- CGACGGGACCACCTTATGTTATTTCATCATG -3' 
     VCU233   5'- CGTATCGACGAATGTGCAAC -3' 
                          
  f02766   PBac5'   5'- CAGTGACACTTACCGCATTGACAAGCAC -3' 
     VCU236   5'- GTCTTTGGGAAGCGTAAAG -3' 
                          
  KG05071   MSG86   5'- CGACGGGACCACCTTATGTTATTTCATCATG -3' 
     VCU239   5'- CCGGAGGTGTGAAGAAAAG -3' 
                          
  c06013   PBac5'   5'- CAGTGACACTTACCGCATTGACAAGCAC -3' 
     VCU233   5'- CGTATCGACGAATGTGCAAC -3' 
                          
  f03305   PBac5'   5'- CAGTGACACTTACCGCATTGACAAGCAC -3' 
     VCU237   5'- GTAGCGCCGTGCCATATAG -3' 
                          
  8   VCU355   5'- CAGCATAAACACGGACAGGG -3' 
     VCU357   5'- GTGAGTCCCCTATTAATCCATAC -3' 
                          
  7   VCU350   5'- GGTCGGAACTGCGTATTCAAC -3' 
     VCU352   5'- CCGATACCATCACGCTGGC -3' 
                          
wishful-thinking e00566   PBac5'   5'- CAGTGACACTTACCGCATTGACAAGCAC -3' 
     VCU246   5'- CTGTCACAGAAATCACACATC- 3' 
                          
  e01243   PBac5'   5'- CAGTGACACTTACCGCATTGACAAGCAC -3' 
     VCU248   5'- GCTACGATGCCTTGCTCTC -3' 
                          
  d02492   MSG86   5'- CGACGGGACCACCTTATGTTATTTCATCATG -3' 
     VCU243   5'- GTTTTGCCGTTTGACTTTTC- 3' 
                          
Baboon k16912   MSG86   5'- CGACGGGACCACCTTATGTTATTTCATCATG -3' 
     VCU210   5'- GCAGAGCAGTTTTTCCAACC -3' 
                          
  c05710   PBac3'   5'- CCTCGATATACAGACCGATAAAACACAT -3' 
     VCU212   5'- GGACATGCTTATCAGTCGCC -3' 
                          
  c04236   PBac5'   5'- CAGTGACACTTACCGCATTGACAAGCAC -3' 
      VCU214   5'- TTTGGATTTGGCTTGTTTCC -3' 
                                         

13 
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1.3 tkv7 and tkv8 Mutation Confirmation 

The presence of the point mutations in tkv7 and tkv8 were confirmed prior to and 

after backcrossing into the w[A] background. Genomic DNA was isolated and standard 

PCR was performed as above. Primers were designed to flank the point mutations by at 

least 50 base pairs (Table 3). Amplification was confirmed by agarose gel 

electrophoresis. The PCR samples were treated with ExoSap-IT to eliminate remaining 

primers and dNTPs from the PCR reaction. Treated PCR samples were sequenced at 

ACGT Inc. (Chicago, IL), and analyzed using Applied Biosystems Sequence Scanner 

v1.0 (© 2005).  

 

1.4 mRNA Isolation and cDNA Synthesis 

Flies were collected under anesthesia, frozen at -20◦C, and then homogenized in 

Trizol® (Invitrogen #15596-018). An mRNA pellet was isolated, washed with 75% EtOH,  

dried at room temperature, reconstituted with DEPC water, placed at 4◦C overnight and 

stored at -20◦C until needed. The mRNA concentration was measured using 

spectrophotometry (Ultraspec 200 Pharmcia Biotech). 

Reverse transcription was performed by adding 6ug (total volume of 17uL) of 

mRNA to a DNAse enzyme (InvitrogenTM #AM1906). After treatment with DNAse, the 

DNAse enzyme was inactivated by a DNAase inactivation agent (InvitrogenTM 

#AM1906). cDNA synthesis was then carried out by Oligo(dT) (InvitrogenTM #58862), 

DTT (InvitrogenTM #Y0147),1st Strand Buffer (InvitrogenTM #Y02321), dNTPs, and 

Superscript II® enzyme (InvitrogenTM #91681). All cDNA samples underwent a quality 

control check to confirm that there was minimal genomic DNA present by standard PCR 
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with primers VCU86 (5’- CACGGGAAAACACTGGCAATC -3’) and VCU87 (5’- 

CTGGCCCAGATCAGAGGTT -3’) to detect Doc3 . 

 

1.5 Quantitative Real Time PCR  

Quantitative real time PCR (qRT-PCR) was performed on an Applied 

BiosystemsTM 7500 Fast Real-Time PCR System to determine expression of the TGF-β 

receptor gene of interest. Prior to examining expression levels, all primer sets (Table 4) 

were tested to ensure (1) proper amplification of cDNA serial dilutions and (2) 

appropriate dissociation characteristics. Primers found to have slopes in the cDNA 

dilutions of ~-3.5 and single dissociation peaks were used to measure expression levels 

of the TGF-β receptor genes (Figure 2) in cDNA diluted 1:4. Diluted cDNA was added to 

ddH2O, SYBER green (Quanta Biosciences), and primers from a 3pmol/µL working 

concentration in triplicate. Data were analyzed with 7500 Fast System software v1.3.1 

(Applied Biosystems © 2001-2004).  Relative expression of the TGF-β receptor genes 

was determined using the delta-delta Ct method (Livak and Schmittgen, 2001). 
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Table 4. qRT-PCR Primers 

Gene   Primer ID                   Primer Sequence   

thickveins   VCU310   5'- CGAGGAGGAGCGTACATATG -3' 
                 
   VCU311   5'- GAAGACAACGGTGGTTTTCTC -3' 

                
   VCU312   5'- TCGCAGCAGACAATGTTCTTG -3' 

                
   VCU313   5'- CAGGTCACGGTTGCAGAA G -3' 

                
wishful-thinking   VCU204   5'- GCCCAGATGGCTACACTTTC -3' 

                
   VCU205   5'- GACTGGCTGCAAATGGAAG -3' 

                
   VCU206   5'- GCGCTGTTGAGCTATTTCG -3' 

                
   VCU207   5'- GCATTCGCTGAAAGTTAGGG -3' 

                
baboon   VCU258   5'- AACCTGATCCCAGCATTGAG -3' 

                
   VCU259   5'- GGGATACCAGCACTCCTTCA -3' 

                
   
   
   

VCU260   5'- GGTGGTTTGCATCGAGAAGT -3' 
             

VCU261   5'- TGGGATACCAGCACTCCTTC -3' 
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Figure 2. Standard Curves of Primers Used in qRT-PCR for Each Gene and 

Control. (A.) Actin primers VCU45 and VCU46, slope= -3.16, r2= 0.98. (B.) tkv primers 

VCU310 and VCU312, slope= -3.75, r2= 0.99. (C.) wit primers VCU205 and VCU207,  

slope= -3.35, r2= 0.97. (D.) babo primers VCU258 and VCU259, slope= -3.5, r2= 0.98 
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1.6 Ethanol Rapid Iterative Negative Geotaxis 

 To test sedation in response to acute exposure to ethanol, flies were tested using 

the ethanol Rapid Iterative Negative Geotaxis assay (Bhandari et al., 2009). In this 

assay, groups of flies are stimulated to climb (startle-induced negative geotaxis) in the 

presence of ethanol. Ethanol time-dependently and dose-dependently inhibits climbing 

behavior. Groups of 25 female flies, approximately 3-5 days old, of a single genotype 

were collected under brief CO2 anesthesia and placed in individual non-yeasted food 

vials. Flies were allowed to recover from anesthesia at 25◦C and 60% humidity overnight 

prior to behavioral testing. 

 Base line negative geotaxis was determined by a water test in which flies were 

placed in vials containing a cotton plug with 500µL of ddH2O. Each vial was placed in a 

rig in between a camera and a light source (Figure 3 modified from Bhandari, Bettinger 

et al. 2009). The rig containing the vials of flies was rapidly banged against the table 3 

times to induce negative geotaxis behavior. A picture was taken (Canon Power Shot G3 

Digital Camera) after 4 seconds to allow time for the flies to climb up the sides of the 

vials. This was repeated after a one minute rest period twice. Ethanol exposure 

occurred the same way as above except that 20% EtOH was added to the cotton flug. 

Ethanol tests were run under continuous exposure to EtOH for 20 minutes. 
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Figure 3. ethanol Rapid Iterative Negative Geotaxis. (Above) Depiction of eRING 

set-up with camera in front of an apparatus holding vials that contain flies, a cotton plug, 

and water or ethanol vapor. (Below) Apparatus containing vials that during testing hold 

flies with either water or ethanol vapor. 
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Pictures of flies from eRING studies were prepared for analysis using Adobe ® 

Photoshop ® 5.0 (© 1989-1998). Pictures were then analyzed using Scion Image (Β 

4.0.2 © 2000). For each time point of each individual vial tested, negative geotaxis (cm) 

values were calculated in Microsoft Excel from the data points extracted using Scion 

Image. T50 values (the time required for ethanol to inhibit negative geotaxis by 50%) 

were interpolated using a 3rd order polynomial calculation in GraphPad Prism v4.02 (© 

1992-2004).  

 

1.7 Internal Ethanol Content 

 To test any pharmacokinetic differences in the various genotypes tested, internal 

ethanol content was examined at 0 (water), 5 and 10 minutes of ethanol (20%) 

exposures in eRING assays using female flies collected and recovered as described 

above. After exposure to ethanol, each set of flies was frozen at -20◦C until 

homogenized in ice-cold ddH2O and centrifuged at maximum speed for 20 minutes. An 

aliquot of the resulting supernatant was added to alcohol reagent (Pointe Scientific Inc, 

#A7504-150) and incubated at 30◦C for 5 minutes. Absorbance at 340 nm was taken for 

each sample in triplicate and preliminary internal ethanol concentrations were 

determined from linear regression/interpolation from a standard curve. Fly volumes 

were determined by weighing 25 female flies before and after drying at 55°C for up to 

24 hours. Final ethanol concentrations were calculated from the volume of water in flies 

as follows: mM interpolation x (3/10) x (200uL / [# of flies x uL/fly]). 
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CHAPTER 2 

Molecular and Behavioral Characterization of the TGF-β Receptor Gene, tkv, in 

Ethanol Sensitivity. 

 
 
 

Introduction 

Vertebrate Clic proteins are required for TGF-β signaling in cardiomyocytes 

(Shukla et al., 2009) and preliminary studies in our laboratory suggested that RNAi-

mediated knockdown of the Type I TGF-β receptor gene thickveins (tkv) blunts ethanol 

sensitivity in flies (data not shown, Bhandari and Grotewiel, unpublished). Thus, I 

hypothesized that Clic might influence ethanol sensitivity via its participation in TGF-β 

signaling. I chose to investigate this potential mechanism by exploring the role of TGF-β 

receptors in ethanol sensitivity. The simplest prediction from my hypothesis is that 

decreased tkv expression will blunt acute sensitivity to ethanol. Such a change in 

ethanol sensitivity in response to altered TGF-β signaling would be consistent with our 

proposed mechanism of CLIC action in ethanol sensitivity (Bhandari et al., 2012).  

 

Transposon Insertion Mutants in tkv 

 Prior to genetic analysis of the TGF-β receptor tkv in acute ethanol sensitivity, I 

obtained several transposon insertions in tkv (Table 1, Figure 4). To confirm the 

positions of the transposon insertions, I performed standard PCR on genomic DNA 
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isolated from each strain using primers that flanked the reported positions of the 

transposons in combination with a primer that annealed to the terminal repeats with 

each transposon (Table 1, Figure 4). I confirmed the positions of four transposon 

insertions (d07811, f02766, f03305, and c06013) (Figure 4). Despite vigorous attempts 

with multiple primer pairs, I was unable to confirm the location of KG05071 and it 

formally remains unmapped. I am confident, however, that this transposon insertion 

disrupts tkv function based on my assessment of complementation for viability and tkv 

expression (see below). All transposon insertions were backcrossed for seven 

generations to w[A], our standard laboratory reference stock, to control for genetic 

background effects in our experiments (Thomas and Grotewiel, unpublished).  
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Figure 4. Mapped Transposons in the thickveins Gene. All transposons confirmed at the predicted positions 

except KG05071. Green indicates homozygous viable, black indicates homozygous lethal.
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To assess my major hypothesis, I analyzed tkv expression and acute ethanol 

sensitivity in parallel in all tkv transposon mutants. I determined tkv expression by 

quantitative Real-Time PCR (qRT-PCR) for each transposon insertion line. Total 

expression of tkv was significantly decreased in c06013/+ and KG05071/+ 

heterozygotes (23.33% and 61.2% respectively), but not in the f03305/+ heterozygote or 

in d07811/d07811 and f02766/f02766 homozygotes compared to w[A] control flies 

(defined as 100%) (Figure 5a, Table 7).   

 I assessed acute ethanol sensitivity in ethanol Rapid Iterative Negative Geotaxis 

(eRING) assays (Bhandari et al., 2009) using 20% ethanol. eRING assays measure 

bang-induced climbing in the continuous presence of ethanol vapor. By determining T50 

values (the time required for climbing to be inhibited 50% by ethanol) from these 

studies, I can determine their acute sensitivity to ethanol. Typically, w[A] control flies 

exhibit T50 values of 5-8 minutes under these conditions. Flies homozygous for the 

transposon insertions d07811 and f02766 (Figure 6a and b) or heterozygous for 

KG05071 (Figure 6c) had a significant increase in T50 values, indicating that these 

transposon lines are less sensitive to ethanol than control animals. T50 values were 

unchanged, however, in other flies heterozygous for the transposons c06013 and 

f03305 compared to controls (Figure 6d and e). Thus, ethanol sensitivity is blunted in 

flies harboring some, but not all, transposon insertions evaluated. 
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Figure 5. qRT-PCR Analysis of tkv Expression in Simple Heterozygous and 

Homozygous Transposon Insertion Strains.  (A.) Total expression of all transcripts of 

tkv . (B.) Expression of tkv transcript A.  (C.) Expression of tkv transcript B.   

(D.) Expression of tkv transcript D. One sample t-test, * p = 0.05-0.01, 

 ** p-value = 0.009-0.005, *** p-value= 0.004-0.001,**** p-value= 0.0009- <0.0001. 

Filled bars indicate genotypes with blunted ethanol sensitivity. 
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Figure 6. Ethanol Sensitivity in Simple Heterozygous and Homozygous tkv 

Transposon Insertion Strains.  Ethanol sensitivity (T50) values in control w[A] (open 

bars) and tkv transposon lines (closed bars). T50 values are increased in (A) d07811 

homozygotes (t test, p<0.0001), (B) f02766 homozygotes (p=0.0054) and (C) 

KG05071/+ heterozygotes (p= 0.001) compared to w[A] control flies. T50 values in (D) 

c06013 and (E) f03305 heterozygotes were unchanged relative to w[A] controls. n= 8-

15. 
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The increased T50 values in 3 independent strains with transposon insertions in 

tkv suggest that this gene might influence acute ethanol sensitivity. I note, however, that 

total expression of tkv does not appear to correlate with ethanol sensitivity. Specifically, 

KG05071/+ heterozygotes and d07811 and f02766 homozygous flies have blunted 

ethanol sensitivity, but only KG05071/+ flies have decreased total expression of tkv. 

Further, although c06013/+ had a significant decrease in total tkv expression, ethanol 

sensitivity was not substantially altered in this genotype. If tkv influences ethanol 

sensitivity, therefore, this affect cannot be explained by changes in total tkv expression 

measured by qRT-PCR.   

There are four (A-D) predicted transcripts from the tkv locus. I therefore 

hypothesized that there might be a pattern of changes in expression of the individual tkv 

transcripts that correlates with the altered ethanol sensitivity in transposon insertion 

genotypes. To measure expression of each transcript individually, we developed qRT-

PCR assays using isoform-specific primers for transcript A, B and D (data not shown, 

Chan and Grotewiel, unpublished). Transcript C was not consistently detected in 

multiple experiments using several different primer pairs, indicating that tkv-C is not 

highly expressed in adults or that none of the primers used to detect this transcript work 

well. Given the difficulty of detecting transcript C, expression of this isoform was not 

considered further.   

 Expression of transcript A was not altered in any of the transposon lines (Figure 

5b), while transcript B was significantly decreased in all transposon lines tested (Figure 

5c). Transcript D was decreased in f03305/+ flies only (Figure 5d). Taken together the 

qRT-PCR results indicate that there is differential expression among the isoforms but 
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not necessarily among the mutants. More importantly, I found no clear pattern of 

change in expression of tkv isoforms that explained the blunted sensitivity to acute 

ethanol. 

It seemed possible that ethanol uptake or metabolism might be altered in tkv 

transposon insertion lines and that the resulting changes in internal ethanol 

concentrations might explain the T50 values found in these animals. To measure 

internal ethanol content, flies were exposed to either water (0 min time point) or 20% 

ethanol for 5 or 10 minutes. As expected, internal ethanol concentrations increased with 

time of ethanol exposure (Figure 7). I found no differences in internal ethanol 

concentration in control w[A] and tkv transposon insertion strains (Figure 7).  Altered 

internal ethanol content, therefore, cannot explain the presence or absence of altered 

sensitivity to acute ethanol in tkv transposon strains. 
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Figure 7. Internal Ethanol Content of Simple Heterozygous and Homozygous 

Transposon Strains.  Time (p<0.0001), but not genotype (n.s.), influenced internal 

ethanol content (two-way ANOVA). 
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Complementation for Ethanol Sensitivity 

 Genetic complementation is a powerful approach to determine whether a locus 

plays a role in a particular process or phenotype. I exploited this approach to further 

probe the possible connection between tkv and sensitivity to acute ethanol.  

Complementation works best with recessive alleles and I consequently excluded 

KG05071 from the behavioral portion of these studies because it had a dominant effect 

on ethanol sensitivity (Fig 5c). 

 I first determined all combinations of the transposon insertions that 

complemented for viability.  Many combinations of the tkv alleles in trans were not 

viable (i.e. noncomplementation, Table 5). The combination of molecular mapping 

(Table 1, Figure 4), gene expression changes (Figure 5) and these complementation 

studies strongly indicate that transposons KG05071, c06013 and f03305 are all loss of 

function alleles of tkv.  Importantly, f03305 and c06013 were viable in trans to d07811, 

raising the possibility that I can use these allelic combinations in complementation 

analyses to further probe the role of tkv in ethanol sensitivity.   
 

Table 5. Complementation for Viability in tkv 
Transposon Insertions 
  c06013 f03305 d07811 7 8 
KG05071 failed failed full failed failed 
c06013  failed full failed failed 
f03305   full failed failed 
d07811    full full 
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I next hypothesized that f03305 and c06013 in trans to d07811 would not 

complement for ethanol sensitivity and tkv expression.  c06013/d07811 and 

f03305/d07811 both exhibited a significant decrease in total tkv expression compared to 

w[A] controls (Figure 8a). I also examined the expression of individual tkv isoforms as 

part of this series of complementation experiments.  Expression of tkv-A was not 

significantly changed in f03305/d07811 or c06013/d07811, while tkv-B was decreased 

in both transheterozygotes (Figure 8b and c). tkv-D was not changed in c06013/d07811, 

but this isoform was decreased in f03305/d07811 (Figure 8d). These qRT-PCR studies 

confirm that c06013/d07811 and f03305/d07811 are partial loss of function genotypes. 

 To determine whether f03305 and c06013 complemented d07811 for acute 

ethanol sensitivity, I compared T50 values from eRING studies using 20% ethanol in 

w[A] controls, flies heterozygous for f03305, c06013 and d07811, and in flies with 

f03305 and c06013 in trans to d07811. T50 values were significantly greater in 

f03305/d07811 flies compared to w[A] controls and f03305 and d07811 heterozygotes 

(Figure 9a). Similarly, c06013/d07811 also exhibited a blunted sensitivity to ethanol 

when compared to w[A] control flies, but T50 values in this transheterozygous 

combination were not significantly different than c06013 and d07811 heterozygotes 

(Figure 9b). The simplest interpretation of these data is that f03305 and c06013 do not 

complement d07811 for sensitivity to acute ethanol and therefore that tkv is involved in 

this behavioral response to ethanol. 
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Figure 8. qRT-PCR Analysis of tkv Expression in Transheterozygotes.  (A.) Total 

expression of all transcripts of tkv. (B.) Expression of tkv transcript A. (C.) Expression of 

tkv transcript B. (D.) Expression of tkv transcript D. * p-value = 0.05-0.01, ** p-value = 

0.009-0.005, *** p-value= 0.004-0.001,**** p-value= 0.0009- <0.0001.  
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Figure 9. Ethanol Sensitivity in Transheterozygote Insertion Strains * p-value = 

0.05-0.01, ** p-value = 0.009-0.005, *** p-value= 0.004-0.001,**** p-value= 0.0009- 

<0.0001. Filled bars indicate ethanol phenotype. n= 17-19. 
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I also assessed internal ethanol concentrations to determine whether the blunted 

ethanol sensitivity in f03305 and c06013 in trans to d07811 was associated with altered 

ethanol uptake or metabolism. As in the simple transposon strains there was a 

significant effect of time but there was not a significant effect of genotype and no 

significant interaction between time and genotype (Figure 10). The blunted ethanol 

sensitivity in f03305/d07811 and c06013/d07811 flies is therefore likely due to an 

altered pharmacodynamic effect of ethanol as opposed to an altered pharmacokinetic 

effect. 

 Taken together, the expression analysis of tkv and ethanol sensitivity in flies with 

independent alleles of tkv in transheterozygotes is consistent with a decrease in total 

expression of tkv or possibly the tkv-B isoform altering the sensitivity to ethanol (Table 

6). Additionally, my analysis of internal ethanol content in these complementation 

studies indicates that the altered ethanol sensitivity in tkv mutants is related to a change 

in the pharmacodynamic properties of ethanol in these animals.  Although the data from 

my studies on transposon mutants are somewhat complex, multiple experiments 

support the hypothesis that the TGF-β receptor tkv influences ethanol sensitivity in flies. 

 

Table 6. Complementation for Ethanol 
Sensitivity in tkv 

  d07811 

c06013 does not complement 

f03305 does not complement 

tkv7 does complement 

tkv8 does complement 
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Figure 10. Internal Ethanol Content of tkv Transheterozygote Insertion Strains. 

There was no effect of genotype on internal ethanol (two-way ANOVA, n.s.), but there 

was a significant effect of time (p<0.0001). 
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Point Mutant Loss of Function tkv Alleles 

 Given the complexities in my data from studies using transposon insertion 

mutants, I decided to further test the global hypothesis that tkv influences ethanol 

sensitivity by using previously characterized point mutant loss of function alleles in tkv. I 

predicted that flies harboring tkv point mutations would exhibit blunted sensitivity to 

ethanol or that the tkv point mutations would not complement tkv transposon insertions 

for ethanol sensitivity.  

Two homozygous lethal point mutant alleles (tkv7 and tkv8) were obtained from 

the Drosophila Stock Center (Bloomington, Indiana). tkv7 contains a single point 

mutation that changes G>A and consequently a glutamic acid to a lysine (E528K) at a 

conserved residue in the C-terminus of the kinase domain (Nellen et al., 1994). tkv8 

contains an independent point mutation that changes C>A and introduces a predicted 

termination in the extracellular domain of TKV at C156 (Nellen et al., 1994). Both point 

mutants were backcrossed to a d07811 stock that had been previously backcrossed to 

w[A], thereby moving the tkv point mutants into the w[A] background.  Each point 

mutation (heterozygous) was confirmed by DNA sequencing before and after 

backcrossing (Figure 11 and 12). 
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A. 

 

B. 

 

Figure 11.Sequence Analysis of tkv7 Point Mutation. (A.) Sequence of tkv7 point 

mutation prior to backcross. (B.) Sequence of tkv7 point mutation after backcross. Arrow 

indicates heterozygous locus containing the point mutation. 
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A. 

 

B. 

 

Figure 12.Sequence Analysis of tkv8 Point Mutation. (A.) Sequence of tkv8 point 

mutation prior to backcross. (B.) Sequence of tkv8 point mutation after backcross. Arrow 

indicates heterozygous locus containing the point mutation. 
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I evaluated ethanol sensitivity in tkv7 and tkv8 heterozygotes as well as these two 

tkv alleles in trans to the d07811 transposon. In contrast to my results with transposon 

insertions, I found no significant change in T50 values in tkv7/+ or tkv7/d07811 

compared to w[A] controls or d07811/+ heterozygotes (Figure 13a). Similarly, I found no 

effect of the tkv8 allele when tested as a heterozygote or in trans to d07811 (Figure 

13B). These results are not consistent with my data derived from studies with 

transposon insertions and therefore do not support the hypothesis tkv is important for 

ethanol sensitivity in flies. 
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Figure 13. Ethanol Sensitivity in tkv7 and tkv8 Heterozygous and 

Transheterozygous Mutants. (A.) There is no significant difference in T50 values 

between control and tkv7/+ or control tkv7/d07811. (B.) There is no significant difference 

in T50 values between control and tkv8/+ or control tkv8/d07811. n= 7-10 
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Global and Tissue-Specific Knockdown of tkv by RNAi 

 Preliminary studies of RNAi-mediated knockdown of tkv ubiquitously or in the 

muscle indicated that tkv influences acute sensitivity to ethanol (data not shown, 

Bhandari and Grotewiel, unpublished). I attempted to confirm these preliminary studies 

by determining whether ubiquitous or muscle-specific expression of two independent 

UAS-tkv-inverted repeat (IR) lines (3059 and 105834, Table 2) altered ethanol 

sensitivity. Based on the preliminary data, I hypothesized that the two independent UAS 

tkv IR transgenes would exhibit a significant blunting of ethanol sensitivity upon global 

and muscle-specific knockdown. 

 In initial studies using 20% ethanol, I found that the flies for this experiment did 

not become sufficiently sedated and therefore that acute ethanol sensitivity could not be 

determined. I reasoned that increasing the ethanol concentration might help resolve 

differences between genotypes and therefore used 30% ethanol for subsequent RNAi 

studies. In each RNAi experiment, I compared T50 values for flies harboring a single 

copy of (ubiquitous) Actin-Gal4 or (muscle) mef2-Gal4, flies with a single copy of UAS-

tkv-IR 3059 or 105834, and flies with Actin-Gal4 or mef2-Gal4 driving UAS-tkv-IR 3059 

or 105384.  All flies used in these RNAi studies were generated in a F1 hybrid 

w[A]/w[VDRC] genetic background.  In contrast to the preliminary studies, I found no 

substantive difference between flies with a single copy of the Gal4 driver and presumed 

tkv knockdown flies (Figure 14).  These data do not support the hypothesis that tkv 

influences ethanol sensitivity, although the low relative sensitivity of Actin-Gal4/+ flies 

could be masking any significant change in ethanol sensitivity in 3059/Actin-Gal4 or 

105834/Actin-Gal4 flies.  
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Figure 14. Ethanol Sensitivity of tkv RNAi Knockdown Flies. (A.) Global knockdown 

of the UAS 3059 tkv allele with actin-Gal4. (B.) Muscle-specific knockdown of the UAS 

3059 tkv allele with Mef2-Gal4. (C.) Global knockdown of the UAS 3059 tkv allele with 

actin-Gal4. n= 10-12. 
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Conclusions 

 Initial complementation for viability strongly indicates that the transposons used 

in this study were in the tkv gene and caused loss of function of TKV. Analysis of acute 

ethanol sensitivity in these transposon insertions revealed a significantly blunted 

sensitivity in some but not all of these tkv mutated flies (Table 7). Expression analysis 

indicated that total tkv expression is not correlated to sensitivity (Table 7). However 

since the expression of tkv-B is decreased across all transposon insertions this might 

indicate that this is the transcript being acted on by the transposon insertions. These 

results support the hypothesis that tkv does influence acute ethanol sensitivity. 

 However, RNAi knockdown of tkv and LOF alleles for tkv that were tested as part 

of this study do not support this hypothesis. This is in part due to inconclusive results of 

the RNAi studies where the controls with significant resistance to ethanol might be 

masking any blunted ethanol sensitivity in the knockdown flies. Further studies should 

be done on tkv to determine how tkv is influencing acute sensitivity to ethanol and its 

role in the mechanism for Clic involvement in acute ethanol sensitivity. 

Table 7. tkv Transposon Expression and EtOH Sensitivity Summary  

genotype total tkv 
expression 

tkv-A 
expression

tkv-B 
expression

tkv-D 
expression 

EtOH 
Sensitivity 

d07811/d07811 94% 105% 24%* 103% 223%* 
f02766/f02766 94% 100% 20%* 268%* 161%* 
      
KG05071/+ 39%* 98% 44%* 97% 252%* 
c06013/+ 77%* 123% 64%* 124% 116% 
f03305/+ 83% 87% 37%* 51%* 107% 
      
c06013/d07811 56%* 95% 59%* 77% 175% 
f03305/d07811 43%* 106% 47%* 29%* 215%* 
      
all measures as percent of w[A] control, * indicates significance p<0.05  
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CHAPTER 3 

Preliminary Molecular and Behavioral Characterization of the TGF-β Receptor 

Genes wishful-thinking and baboon in Drosophila Ethanol Sensitivity 

 

 

Introduction 

 For a more complete view of TGF-β receptors and their roles in acute ethanol 

sensitivity, I examined the TGF-β receptor genes wishful-thinking (wit) and baboon 

(babo). babo encodes a Type I receptor and wit encodes a Type II receptor. As with tkv, 

I hypothesized that decreased expression of wit or babo would blunt sensitivity to 

ethanol. Below is preliminary data for both wit and babo expression and acute ethanol 

sensitivity in a series of flies with transposon insertions in these two genes. 

 

A. wishful-thinking 

 To study the influence of wit on acute ethanol sensitivity, I obtained three 

transposon insertions in the gene. These transposon insertions are near or in the 5’ and 

3’ UTRs, locations that I confirmed by standard PCR with primers that annealed to the 

transposon and near the reported insertion sites (Table 1, Figure 15).  
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Figure 15. Mapped Transposon Insertions in the wishful-thinking Gene.
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I evaluated total wit expression by qRT-PCR for the three homozygous viable 

transposon insertions, e00566, e01243, and d02492. This analysis revealed that in the 

[e00566] flies there was a significant upregulation of wit expression by over 4-fold (Fig. 

16). There was a significant decrease in expression in the d02492 transposon carrying 

flies, but there was no significant change in expression in the e01243 transposon line 

(Figure 16).  

 To assess acute ethanol sensitivity in these transposon lines, I used the eRING 

assay with 20% ethanol. The T50 values from all three wit transposon strains were 

significantly different from w[A] control animals (Figure 17), suggesting that that wit 

might influence acute ethanol sensitivity. Although complex, these results could lead to 

follow-up studies that more formally address the role of wit in acute ethanol analysis 

using RNAi knockdown and point mutant LOF alleles. 
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Figure 16. qRT-PCR Analysis of wit Expression in Transposon Strains. 

 **** p-value 0.0009- <0.0001. 
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Figure 17. Ethanol Sensitivity in wit Transposon Insertion Strains.  

(A.) e00566/e00566. (B.) e01243]/[e01243. (C.) d02492/d02492.  

***p-value 0.004-0.001. Open bars indicate control, filled bars indicate transposon 

insertion. n= 9-10. 
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B. baboon 

 As with wit, I used transposon insertions in babo to do a preliminary assessment 

of the influence of this gene on acute ethanol sensitivity. These transposons were 

located in the non-coding 5’ UTR and introns of the babo gene (Table 1, Figure 18). I 

used standard PCR to confirm the three transposon insertions (k16912, c05710, and 

c04236) used in this study (Table 1). 

 I evaluated total expression of babo by qRT-PCR and observed a significant 

decrease in the expression of babo in the c05710 and k16912 heterozygous transposon 

lines (Figure 19). There was no change in expression of c04236 heterozgyotes. I also 

performed an eRING assay on these transposon lines to assess acute ethanol 

sensitivity. There was no significant difference between these transposon lines and the 

w[A] control in T50 values when exposed to 20% ethanol (Figure20).  

 The lack of a blunted acute ethanol phenotype observed in this preliminary study 

does not support the hypothesis that babo influences acute ethanol sensitivity. Based 

on these results, further studies of babo will likely not be fruitful in studying acute 

ethanol sensitivity. 
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Figure 18. Mapped Transposon Insetions in the baboon Gene.
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Figure 19. qRT-PCR Analysis of babo Expression in Transposon Strains. 

 **p-value 0.009-0.005, ***p-value 0.004-0.001.  
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Figure 20. Ethanol Sensitivity in babo Transposon Insertion Strains.  

(A.) c04236/+. (B.) c05710/+. (C.) k16912/+. There is no significant difference in T50 

values in babo mutants compared to controls. Open bars indicate controls, closed bars 

indicate transposon insertions. n=9-10. 
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Conclusions 

 These preliminary data suggest there might be very different roles of wit and 

babo in acute ethanol sensitivity. I observed significant increases in T50 values of 

homozygous wit transposon insertions by eRING analysis. This may indicate there 

might be a potential influence of wit on acute ethanol sensitivity. I suggest that further 

studies be done to determine this potential role of wit on ethanol sensitivity. However, 

due to the evidence from these eRING studies of transposon insertions in babo that 

babo might not influence acute ethanol sensitivity, I do not believe further studies on 

babo would be beneficial.  
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CHAPTER 4 

Summary 

 

 

 Alcohol abuse and dependence are diseases with far reaching consequences. It 

is estimated that nearly 50-60% of the risk variance for developing alcohol abuse or 

dependence is genetic (APA, 2000). The genetic component of alcohol abuse is 

considered polygenic with many genes of presumed small effects influencing the risk 

variance. In an effort to further understand the genetic components of alcohol abuse 

and dependence, large scale meta-analyses have been done to populate a list of 

potential influencing genes. 

 From this analysis the Clic gene was identified. Clic is known to be involved a 

wide range of biochemical processes beyond the chloride intracellular channels as the 

name suggests. A recent study done by Bhandari et al. (2012) shows a cross species 

detailed analysis of the influence of Clic on acute ethanol sensitivity. Specifically in 

Drosophila, the decreased expression of Clic blunts acute ethanol sensitivity (Bhandari 

et al., 2012). While this study provides strong evidence for the influence of Clic on acute 

ethanol sensitivity, it does not provide a mechanism for why this change of sensitivity 

occurs when Clic expression is decreased. As mentioned above, Clic is involved in 

many different biochemical pathways including binding to AKAP proteins, interactions 
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with ryanodine receptors and 14-3-3, as well as involvement in the TGF-β signaling 

pathway (Suginta et al., 2001; Shanks et al., 2002; Jalilian et al., 2008) (Shukla et al., 

2009). The later pathway was the focus of this thesis research project. 

 Shukla et al. (2009) showed that vertebrate Clic4 functions within the TGF-β 

signaling pathway by associating with Schnurri-2 upon activation of the pathway, 

translocating from the cytoplasm to the nucleus where it dissociates from Schnurri-2 

and then binding of SMADs to regulate transcription of downstream genes. This direct 

involvement in signal transduction in the TGF-β signaling pathway suggested that this 

might be the mechanism by which Clic influences acute ethanol sensitivity. To further 

determine if this potential mechanism for the change in ethanol sensitivity observed 

when Clic is mutated in flies, I examined TGF-β receptor genes. 

  In both mammals and invertebrates, such as Drosophila, there are two TGF-β 

receptor classes, type I and type II. These receptors associate to form a heterotetramer 

when the TGF-β ligand binds. In Drosophila there are three Type I receptor genes 

(thickveins, baboon, and saxophone) and two Type II receptor genes (wishful-thinking 

and punt).  

 The global hypothesis for this study was that TGF-β receptors, specifically 

thickveins, influence acute sensitivity to ethanol in Drosophila. To first examine this 

genetic influence on acute ethanol sensitivity, I obtained transposon insertions in the tkv 

gene and confirmed the presence of each transposon. Once confirmed, I examined the 

expression of tkv, acute ethanol sensitivity and internal ethanol concentrations in these 

transposon insertion lines. 
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 These experiments show that five independent transposon insertions in tkv 

exhibit a broad range of tkv expression as determined by qRT-PCR.  These mutants 

further exhibited a broad range of T50 values when tested in the eRING assay. No 

direct correlation was found between the expression of tkv and the sensitivity to ethanol 

in these mutants. I hypothesized that since there are four different isoforms of tkv that 

there might be a differential expression among these isoforms in these transposon 

mutants. There was a significant decrease in the tkv-B transcript in all the transposon 

strains. This decreased expression may indicate that the B transcript of tkv might be the 

specific isoform that is being affected by the transposon insertions. Otherwise, no 

simple correlation was found in the expression of these simple isoforms and ethanol 

sensitivity. Further, to test what was being observed in these mutants was not a result of 

a pharmacokinetic effect, I examined the internal ethanol content in these mutants. No 

difference was seen among the genotypes indicating that the sensitivity observed was 

not a pharmacokinetic effect but a pharmacodynamic effect. 

 To follow up on these transposon experiments, I performed a series of supporting 

experiments, including complementation experiments, RNAi knockdown and LOF point 

mutations. When in trans to each other, selected transposons did not complement for 

acute ethanol sensitivity. This further supported my hypothesis that tkv influences acute 

ethanol sensitivity. The presumed knockdown of tkv by RNAi did not exhibit blunted 

acute ethanol sensitivity. This lack of expected blunting of acute ethanol sensitivity was 

also found in studies with the two LOF alleles tested as well as the LOF allele in trans to 

the d07811 transposon insertion. Since there was a blunting of ethanol sensitivity 

observed in some of the transposon lines and in the complementation experiment, tkv 
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might influence sensitivity to ethanol, however this was not supported by follow-up 

experiments addressed above. 

 In summary, some of my data strongly implicate tkv in ethanol sensitivity and 

some of my data do not. The role of tkv in ethanol sensitivity, therefore, remains 

unclear.  If tkv is important for ethanol sensitivity as predicted by my major hypothesis, 

there must be a fairly complex relationship between tkv expression and the behavior.  

For example, it is possible that the qRT-PCR data do not reflect protein expression 

levels, that tkv expression during development is important for the behavior, that the 

behavior is sensitive to altered expression of tkv in select tissues only, or some 

combination of these or other complexities. To address this I propose using western blot 

analysis of tkv in different tissues and at different ages of the fly. Alternatively, it is 

possible that tkv simply is not important for ethanol sensitivity in flies and that the 

altered T50 values in tkv transposon lines are due to changes in expression of other 

nearby or possibly distant genes. For example, several cytochrome P450 genes reside 

in the 5’ region of the tkv transcription unit and it could be possible that disruption of 

these embedded genes influences ethanol sensitivity. The genes local to tkv could be 

examined by a combination of qRT-PCR analysis and western blot analysis. These 

additional studies that address tkv protein expression levels, tkv expression during 

development and expression of genes near tkv could help resolve the relationship 

between tkv and ethanol sensitivity. 

 In addition to tkv, I obtained preliminary data from the Type I receptor gene babo 

and the Type II receptor gene wit. Expression analysis and eRING analysis of acute 

ethanol sensitivity of transposon lines in babo exhibit no changes that would indicate 
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that babo is influencing ethanol sensitivity. On the other hand, follow-up studies should 

be done on wit because eRING analysis of acute ethanol sensitivity potentially indicates 

that wit might be influencing acute ethanol sensitivity.  

 Overall, the evidence for TGF-β receptors role in influencing acute sensitivity to 

ethanol is unfortunately inconclusive. However, it is important to note that there is some 

evidence for tkv and wit on the influence of ethanol sensitivity that should be followed-

up on in further studies. Finally, there should be follow-up studies that confirm that the 

mechanism by which Clic influences acute ethanol sensitivity in Drosophila is through 

the TGF-β signaling pathway. 
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APPENDIX 

Protocols 

 

A. gDNA Isolation 

DNeasy Genomic DNA Isolation 

1. Place up to 50 adult flies in a labeled 1.5 mL snap-cap tube. Add 180 µL sterile 

PBS and 10 µL RNaseA (10mg/mL). Smash and grind with drill/pestle for 15 

seconds. Incubate at room temperature for 2 minutes. 

 

2. Add 20 µL proteinase K solution (kit) and 200 µL Buffer AL (kit) to each tube. 

Vortex and then incubate at 56 C for 10 minutes. 

 

3. Add 200 µL 100% ethanol to each tube and vortex to mix. 

 

4. Pipette mixture from step 3 to a labeled DNeasy column and place in a 2 mL 

collection tube (kit). Spin at 9000 rpm (6600 x g) for 1 minute. Discard flow-

through and collection tube. 
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5. Place the DNeasy column in a fresh 2 mL collection tube (kit) and add 500 µL of 

Buffer AW1 (kit). Spin at 9000 rpm (6600 x g) for 1 minute. Discard flow-through 

and collection tube. 

 

6. Place the DNeasy column in a fresh 2 mL collection tube (kit) and add 500 µL of 

Buffer AW2 (kit). Spin at maximum rpm for 3 minutes. Discard flow-through and 

collection tube. 

 

7. Place the DNeasy column in a new, labeled 1.5 mL snap-cap tube. Add 200 µL 

distilled H2O to membrane in column and incubate 2 minutes at room 

temperature. Spin at 9000 rpm (6600 x g) for 1 minute to elute genomic DNA. 

 

8. Dilute 10 µl of each sample 1:10 in a separate 0.5 mL tube with distilled sterile 

H2O and determine A260/A280 value.  

 

Genomic DNA concentration (µg/mL) = A260 Value x (50mg/mL) x 10  

Reagents and Supplies: 
1.5mL snap-cap tubes 
0.5 ml snap-cap tubes (for determining concentration) 
Sterile PBS (pH 7.4) 
100% ethanol 
RNase A solution (10 mg/ mL in TE) 
56 C water bath or heat block 
Distilled sterile H2O 
 

Contributed by Mike Grotewiel as modified version of Quiagen protocol 

(12/2003).Updated: 4/2008 
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B. mRNA Isolation, cDNA Synthesis, Absolute qRT-PCR Quantification and 

Relative qRT-PCR Quantification 

RNA Preparation (25 fly prep) 

 

A.  Fly collection and initial preparation: 

1.  Wear gloves and collect 25 flies in a 1.5 ml snap cap tube.  Freeze at -80oC 

(long-term storage) or at -20oC (short-term storage). 

2.  Wipe down bench and all pipettes, pipette boxes, etc. with 100% ethanol.  Place 

clean plastic pestles in 50 ml conical tube, cover pestles with chloroform, soak for 20 

minutes.  Transfer pestles to new clean empty 50 ml conical tube and allow to air 

dry.  All water used is DEPC water. 

 

B.  RNA extraction: 

1.  Add 250 µl Trizol to each tube of flies.  Homogenize for 1 minute with drill and 

pestle.   

2.  Add an additional 250µl Trizol to each tube and vortex for 15 seconds.  Incubate 

for 5 minutes at room temperature. 

3.  Add 100µl chloroform to each tube.  Vortex for 15 seconds.  Incubate for 3 

minutes at room temperature. 
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4.  Centrifuge samples at maximum speed (14,000 x g) for 15 minutes at 4oC (in cold 

room). 

5.  Label new 1.5 ml tubes.  Use pipette to remove upper aqueous phase and put in 

new tube (200 µl max).  If you accidentally pipette any fly parts or pink liquid, 

centrifuge samples again and then remove upper layer.  Discard tubes with fly parts 

and pink liquid. 

6.  Add 250µl isopropanol to each tube containing the upper aqueous phase.  Invert 

tube 5 times.  Incubate 10 minutes at room temperature. 

7.  Centrifuge samples at maximum speed (14,000 x g) for 10 minutes 4°C. 

8.  A white pellet on the bottom of each tube should be visible.  Remove liquid from 

tube with pipette.  Add 500µl 75% ethanol (made with DEPC water) to each tube, 

invert 5 times to wash.   

9.  Centrifuge samples at maximum speed (14,000 x g) for 5 minutes 4oC. 

10.  Use a 200 and then a 20 µl pipette to remove all liquid by pellet.  Clean a piece 

of glass plate with ethanol and then chloroform.  Invert tubes on the cleaned glass 

plate.  Air dry until no liquid droplets remain and white pellet becomes clear (30-60 

min). 

11.  Add 50µl DEPC water to each pellet, allow to sit at room temperature for ~60 

minutes, and resuspend by pipetting up and down.  Be patient, this can take awhile. 

12.  Measure RNA concentration:  Blank is 100µl DEPC water.  Samples are 98µl 

DEPC water and 2 µl of RNA sample.  ABS260 x 40µg/ml x 50 = concentration RNA.  

Store RNA samples at  

-80oC until needed. 
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DNAse treatment and reverse transcription 

**The following two steps need to be done on same day** 

A.  DNAse treatment 

1.  Set heat blocks to 37oC and 65oC. 

2.  Place 6µg RNA in 0.5 ml snap cap tube.  Bring total volume to 17 µl with DEPC 

water. 

3.  Add 2 µl DNAse buffer and 1 µl DNAse enzyme.  Incubate at 37°c for 25 minutes. 

4.  Pulse centrifuge samples and then add 2 µl DNAse inactivation reagent.  

Incubate 2 minutes at room temperature.  While incubating flick tube gently to 

resuspend the inactivation reagent throughout the sample.  Sample should be 

cloudy white. 

5.  Spin down 10,000 x g for 1.5 minutes. 

6.  Use pipette to transfer 11 µl of clear upper phase to new 1.5 ml tubes. 

 

B.  Reverse transcription of RNA (~3 µg) 

1.  Add 1 µl of oligo-dT to each sample of DNAse treated RNA. 

2.  Incubate at 65oC for 15 minutes.  Thaw 1st strand buffer, DTT, and 10mM dNTP 

on ice. 

3.  After 65oC incubation, put tubes on ice for 1 minute then pulse spin in centrifuge.  

Keep all samples on ice throughout. 
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4.  Add to each tube:  
4 µl of 5x 1st strand buffer 
2 µl of 0.1M DTT 
1 µl 10mM dNTPs 
1 µl Superscript 2 enzyme (keep in the cold block) 
5.  Incubate at 42°C for 50 minutes. 

6.  Store samples at -20°C. 

7.  Run standard PCR on 1-2µl of cDNA with RT-PCR primers as quality control 

check.  Use VCU86/VCU87 (detects Doc3 cDNA and gDNA) unless you are working 

with Doc3 as a gene of interest (see M.S.G. for alternative primer set). 

 

Notes:  

1.  Use RNAse-free reagents only. 

2.  DNAse treatment reagents from Applied Biosystems (AM1906). 

3.  Reverse transcriptase protocol adapted from company protocol (Gibco/BRL). 

 4.  Reverse transcriptase and buffers are from Invitrogen (18064014) 

5.  Oligo-dT from Invitrogen (18418-012).
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Real-Time PCR:  cDNA titration and dissociation curve for new primers   

A.  Reaction Set-Up   

1.  Dilute primers from 10 pmol/µl to 3 pmol/µl (e.g. 35 µl H2O + 15 µl 10 pmol/µl 

primer). 

2.  Dilute control cDNA per table below.  Scale as appropriate for the number of 

primer pairs. 

 

cDNA 
dilution 

Example:  1 primer pair Example:  2 primer pairs 

1:4 6 µl water + 2 µl cDNA 12 µl water + 4 µl cDNA 
1:8 4 µl water + 4 µl 1:4 cDNA 8 µl water + 8 µl 1:4 cDNA 

1:16 4 µl water + 4 µl 1:8 cDNA 8 µl water + 8 µl 1:8 cDNA 
1:32 4 µl water + 4 µl 1:16 

cDNA 
8 µl water + 8 µl 1:16 cDNA 

1:64 4 µl water + 4 µl 1:32 
cDNA 

8 µl water + 8 µl 1:32 cDNA 

 

Note:  RT-PCR is highly sensitive.  Knobs on pipettes MUST be taped at all possible 

steps when pipetting replicate samples.  Change tips after each volume is 

dispensed. 

3.  Make master mix for each cDNA dilution according to the table below for 

experiments in triplicate.  Pulse vortex (and pulse centrifuge if necessary). 

 each well 
in plate 

final (n=1) 

Master 
for 1 

primer 
pair 

(n=4) 

Master 
for 2 

primer 
pairs 
(n=8) 

Master 
for 3 

primer 
pairs 

(n=12) 

Master 
for 4 

primer 
pairs 

(n=16) 
water 4.5 µl 18 µl 36 µl 54 µl 72 µl
SYBR 7.5 µl 30 µl 60 µl 90 µl 120 µl
cDNA 1 µl 4 µl 8 µl 12 µl 16 µl
F primer 1 µl XX XX XX XX 
R primer 1 µl XX XX XX XX 
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4.  Label one tube for each primer pair for each cDNA dilution (e.g., for 2 primer 

pairs and 5 cDNA dilutions, label 2 x 5 = 10 tubes total). 

5.  Aliquot master mix @ 49.4 µl /tube from step 4, one tube for each primer pair for 

each cDNA dilution.  Some master mix will remain unused. 

6.  Make a master mix of primers for each primer pair by combining/mixing 25 µl of 

the forward and 25 µl of the reverse primers.  Add 7.6 µl of the primer master mix to 

the appropriate tubes from step 5.  Pulse vortex (and pulse centrifuge if necessary). 

7.  Aliquot in triplicate 15µl of each reaction into a 96 well plate.  Some reaction mix 

will remain unused.  Spin plate at 1000 rpm for 2 minutes using the centrifuge in Rita 

Shiang’s lab. 

 

B.  Amplification and Data Acquisition 

1.  Turn on 7500 Fast System machine.  Launch 7500 Fast System software via 

desktop icon.  Place plate in machine. 

2.  Click File -> New.  Set ‘Assay’ to ‘Absolute Quantification (Standard Curve)’.  Set 

‘Run Mode’ to ‘Standard 7500’.  Click ‘Next’. 

3.  If using new primers, click on ‘New Detector’, add name, leave description blank, 

select SYBR as the reporter and choose a color.  When finished adding new 

primers, click on appropriate detectors, click ‘Add’, click ‘Next’. 

4.  A ‘New Documents Wizard’ interface should be visible.  Assign detectors 

(primers) and cDNA dilutions to wells by highlight wells and then checking 

appropriate ‘Use’ box next to the detector.  With wells highlighted, also assign roles 
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for detectors as ‘Standard’ by using drop down menu under ‘Task’ for each detector 

and assign dilution information in the ‘Quantity’ box in decimal format:   

1/4 = 0.25 
1/8 = 0.125 
1/16 = 0.0625 
1/32 = 0.03125 
1/64 = 0.015625 
Click ‘Finish”. 
 

5.  An interface with 3 tabs should be visible.  In the ‘Set-Up’ tab, information on 

primer pair and cDNA dilution should be visible. 

6.  Using the ‘Instrument’ tab, set ‘Sample Volume’ to 15 µl, set ‘Run Mode’ to 

Standard 7500, and ‘Data Collection’ as Stage 3, Step 2 (60.0 @ 1.00). 

7.  Click ‘Add Dissociation Stage’.  **VERY IMPORTANT** 

8.  Name your data file via File -> Save As ->SDS Documents -> Grotewiel Lab -> 

Your Name -> year.mo.da description (e.g. 2011.02.05 daGal4 Akt RNAi). 

9.  Click ‘Start’, wait a couple of minutes to make sure the lid on the machine is 

heating up.  Run will take ~2.5 hours.  Return to remove plate and retrieve data file. 

 

Real-Time PCR:  Relative Quantification 

Reaction Set-Up 

1.  Dilute primers from 10 pmol/µl to 3 pmol/µl (e.g. 35µl H2O + 15µl 10pmol/µl 

primer). 

2.  Dilute cDNA samples as determined in cDNA titration/dissociation curve above. 
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Note:  RT-PCR is highly sensitive.  Knobs on pipettes MUST be taped at all possible 

steps when pipetting replicate samples.  Change tips after each volume is 

dispensed. 

3. Make master mix for each diluted cDNA sample according to table below for 

experiments in triplicate.  A typical experiment would use only 2 primer pairs.  

Pulse vortex (and pulse centrifuge if necessary). 

 

 each well 
in plate 

final (n=1) 

Master 
for 2 

primer 
pairs 
(n=8) 

Master 
for 3 

primer 
pairs 

(n=12) 

Master 
for 4 

primer 
pairs 

(n=16) 
water 4.5 µl 36 µl 54 µl 72 µl 
SYBR 7.5 µl 60 µl 90 µl 120 µl 
cDNA 1 µl 8 µl 12 µl 16 µl 
F primer 1 µl XX XX XX 
R primer 1 µl XX XX XX 

 

4.  Label one tube for each primer pair for each diluted cDNA sample (e.g., for 2 

primer pairs and 2 cDNA samples, label 2 x 2 = 4 tubes total). 

5.  Aliquot master mix @ 49.4 µl /tube from step 4, one tube for each primer pair for 

each cDNA sample.  Some master mix will remain unused. 

6.  Make a master mix of primers for each primer pair by combining/mixing equal 

volumes of the forward and the reverse primers.  Add 7.6 µl of the primer master mix 

to the appropriate tubes from step 5.  Pulse vortex (and pulse centrifuge if 

necessary). 
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7.  Aliquot in triplicate 15µl of each reaction into a 96 well plate.  Some reaction mix 

will remain unused.  Spin plate at 1000rpm for 2 minutes using the centrifuge in 

Rita’s lab. 

 

Amplification and Data Acquisition 

1.  Turn on 7500 Fast System machine.  Launch 7500 Fast System software via 

desktop icon.  Place plate in machine. 

2.  Click File -> New.  Set ‘Assay’ to ‘Relative Quantification Plate’.  Set ‘Run Mode’ 

to ‘Standard 7500’.  Click ‘Next’. 

3.  Click on appropriate detectors, click ‘Add’, click ‘Next’. 

4.  A ‘New Documents Wizard’ interface should be visible.  Assign detectors 

(primers) to wells by highlight wells and then checking appropriate ‘Use’ box next to 

the detector.  With wells highlighted, also assign roles for detectors as ‘Endo’ 

(endogenous control) or ‘Target’ (gene of interest) by using drop down menu under 

‘Task’ for each detector.  Check that wells are labeled with E (endogenous control) 

or T (target).  Click ‘Finish’. 

5.  An interface with 3 tabs should be visible.  Using the ‘Set-Up’ tab, assign 

genotypes or treatment groups by highlighting groups of wells and labeling them by 

typing in the ‘Well Inspector’.  Genotypes can also be assigned without ‘Well 

Inspector’ by highlighting and simply typing. 

6.  Using the ‘Instrument’ tab, set ‘Sample Volume’ to 15 µl, set ‘Run Mode’ to 

Standard 7500, and ‘Data Collection’ as Stage 3, Step 2 (60.0 @ 1.00). 
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7.  Name your data file via File -> Save As ->SDS Documents -> Grotewiel Lab -> 

Your Name -> year.mo.da description (e.g. 2011.02.05 daGal4 Akt RNAi). 

8.  Click ‘Start’, wait a couple of minutes to make sure the lid on the machine is 

heating up.  Run will take ~1.5 hours.  Return to remove plate and retrieve data file. 

C. Standard PCR 

1X Reaction Master Mix 

H2O   25.7uL (or volume to achieve total reaction volume of 50uL) 
10X buffer  5uL 
2.5mM dNTPs 5uL 
50mM MgCL  2uL 
Primer 1  5uL 
Primer 2  5uL 
Taq   0.3uL 
cDNA   2uL (or volume to achieve 200ng) 
Total Reaction Volume: 50uL 

 

Master Mix should be put in a 0.5mL PCR tube. Reactions run on MSG1 Thermo Cycler 

program in Grotewiel Lab.  

 

75 
 



www.manaraa.com

 

D. Agarose Gel Electrophoresis with Ethidium in the Gel 

 

A.  Pouring the gel 

 1.  Select the comb and gel based on the number of samples. 

 2.  Determine the gel volume using the attached chart. 

 3.  Pour appropriate amount of 1XTAE into dedicated agarose container. 

 4.  Add 1% w/v agarose.  For 100 ml gel, use 100 ml 1XTAE plus 1 g agarose. 

5.  Microwave gel mixture 1 minute.  Swirl, and continue microwaving until 

agarose is melted. Typically this requires less than 1 additional minute. 

 6.  Insert casting tray so that gaskets seal on sides. 

 7.  Pipet 2-6 µl ethidium bromide into bottom of casting tray.  See attached chart. 

8.  Pour hot gel mixture into casting tray.  Stir gel-ethidium bromide mixture with 

comb. 

9. Insert comb and let gel cool until solid.  If the gel will not be used within 4 

hours it must be covered in 1XTAE buffer once it solidifies. 

10. Once the gel is solid, gently remove combs and cover the gel in 1XTAE 

buffer. 

 

B.  Sample preparation and loading 

1.  Pipet 10X glycerol dyes (1/10 sample volume) into tube caps.  For a 20 µl 

reaction, use 2µl 10X glycerol dyes. 

76 
 



www.manaraa.com

2.  Cap tubes and centrifuge briefly to collect all solutions in the bottom of the 

tubes. 

3.  Load 15 µL of 1 kb DNA ladder (with the dye already included) into the 

molecular weight standards lane. 

4.  Load appropriate volume of samples, one sample per lane. 

5.  Load the gel so that all samples, including the molecular weight standards, 

are centered. 

 

C.  Running the gel 

 1.  Add 2-6 µl ethidium bromide to bottom buffer tank and disperse with pipet tip. 

 2.  Place gel cover with electrodes on gel apparatus. 

 3.  Connect electrodes to power supply, red to red and black to black. 

 4.  Ensure that the red electrode is at the bottom of the gel.  RUN TO RED! 

5.  Run gel at 50-100 V until lower dye band has migrated approximately 75% of 

the distance to the bottom.  Check every 20 minutes initially, then more often. 

 

D.  Imaging the gel 

 1.  Remove gel from apparatus using the tray and place on transilluminator. 

 2.  Turn on epi-white light.  Center gel, zoom and focus camera. 

 3.  Close door, turn off epi-white light, and turn on UV light. 

 4.  Adjust exposure time until good image appears. 

 5.  Adjust aperture and focus until very good image appears. 

 6.  Freeze image.  Annotate as appropriate. 
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 7.  Save file in "TIF" format to your folder on "Grotewiel-1" and print. 

 8.  Image can be manipulated in Photoshop on "Grotewiel-1". 

 

E.  Table 

gel unit gel size # of 
samples 

buffer agarose ethidium 

B1A 7 X 8 cm 6, 10 300 ml 35 ml 2 µl X 2 
B1 9 X 11 cm 10, 14 500 ml 60 ml 4 µl X 2 
B2 12 X 14 cm 12, 20 800 ml 100 ml 6 µl X 2 
A2 20 X 25 cm 16, 24, 36 3000 ml 300 ml 15 µl X2 
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E. ethanol Rapid Iterative Negative Geotaxis 

Fly Preparation and Collection 

Beginning 21/2 Weeks Prior to Experimentation 

• About 2-4 days prior to seeding bottles the bottles should be taken from the cold 

room and put into the environmental chamber to dry. 

• For each genotype being tested seed 5 to 8 bottles (do not over seed, use only 

10 females). 

• After seeding bottles should be put back in the environmental chamber. 

1-11/2 Weeks Prior to Experimentation 

• After 1 week in the environmental chamber the parents should be removed from 

the bottles (as long as there are a significant number of larvae and pupae 

present on the sides of the bottle). These parents can be used to seed a new set 

of bottles for a second brood or dumped depending on the needs of the 

experiment.   

• Bottles should be placed back into the environmental chamber. If a second brood 

has been set up repeat the above steps of waiting a week then this time dumping 

the parents. 

Week of Experimentation 

• After an additional 5-10 days there should be enough flies to collect from the first 

brood for experimentation. About 1 day prior to collecting set out 3 vials of food 

for each genotype and control being tested in the environmental chamber from 

the cold room.  These vials should be non-yeasted. 

• Collection of these flies should be done with minimal use of anesthesia. 
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• Flies of a single sex should be collected.  Typically only females are collected but 

this can differ depending on the gene and the restraints of the experiment. 

• 25 flies of a single sex are collected then placed into a 1.5mL tube to restrict the 

amount of anesthesia getting into the vial. The flies from the 1.5mL tube are 

dumped into the vial.  Label the vial accordingly and place the vial on its side until 

the flies have woken up. 

• Once 3 vials for each genotype and control are collected, place the vials back 

into the environmental chamber overnight. Testing should begin the day after 

collection. 

 

Experimental Preparation 

Day of/Day Prior to Experimentation 

• Flugs need to be prepared the day of or the day before experiment and not 

before to prevent problems with the flugs. 

• Flugs are found on the top shelf in the fly room of the middle bench on the side 

facing the dissecting microscopes. 

• Flugs come larger than necessary for the experiment. Cut flugs with a blade 

width-wise so that they are roughly the same size. You can cut a single flug into 

about 3-4 pieces while maintaining the same general size. 

• Place glue on one side of the flug without getting too much on the flug. Glue used 

for this procedure is found in the top drawer in the middle of the bench with the 

dissecting scopes. 
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• Place the flug with the glue into a clean vial (i.e. without food) with forceps. 

Gently guide the flug to the bottom of the vial so that glue does not get on the 

sides of the vial. At this point the flug is pointing vertically. When you do get it so 

that it is touching the bottom of the vial, gently push it so that the side with the 

glue is facing the bottom of the vial.  Smash the flug into the bottom of the vial so 

that it fits snuggly and will not come loose. 

• Repeat this for as many vials needed for the experiment.  Once they are all 

completed place them upside down in a vial box and place them either on the 

bench in the fly room or in the RING testing room. 

 

Day of Experiment 

• Prior to experiment and bringing flies into the room the humidity in the RING 

testing room should be set so that the humidity is about 55-60%. This is done by 

turning on the humidifier on the right wall and adjusting accordingly. Make sure 

there is water supply in the humidifier reservoirs. 

• Dilute ethanol to the concentration that was found to be optimal in dosage testing 

(make enough for the total experiment).  Water used for this dilution should be 

ddH20 which is from the purifier in the back of the lab. 

• Get a bottle/tube of ddH2O as well from the same source 

• Turn the light source on under the light diffuser on the table 

• Place memory card in camera and align the camera and tripod so that it frames 

the table and produces a straight picture.  You may wish to take a test picture 

before the test to ensure correct alignment. 
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• Bring the flies into the test room to acclimate at least a few minutes before the 

test begins. 

 

Experimental Procedure 

Water Test 

1. Secure flugs to the vial by pressing down on the flugs with the end of forceps 

2. Pipette 500uL of ddH20 onto the flug being careful not to drip water onto the 

edges of the vial. 

3. Flip flies from each vial into individual vials with flugs for one set of flies. Cover 

each vial quickly with an orange cap so that no flies escape.  

4. Place the capped vials into the rig with the orange cap on the bottom. Carefully 

place the top of the rig so that the vials fit securely in the grooves. 

5. Place a label on the right panel of the rig describing the genotype, the test (i.e. 

water), and date. 

6. Place the rig in front of the light diffuser and make sure the camera is turned on. 

7. Rap the rig three times on the table and start the timer after 3rd rap. 

8. When the timer reaches 3 seconds, press the shutter button on the camera to 

take the picture 

9. Wait until the timer reaches 1 minute and rap the rig against the table 3 times. 

10. When the timer reaches 1 minute 6 seconds, press the shutter button on the 

camera to take the picture 

11. Repeat steps 9 and 10 for minute 2. 
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12. Remove the top of the rig and flip flies back into their original vials until ready to 

do EtOH test. 

13.  Repeat all steps for each set of flies that are being tested. 

 

NOTE: You may wish to record the pictures being taken in a notebook for reference 

when doing data analysis. 

 

EtOH Test 

1. Secure flugs to the vial by pressing down on the flugs with the end of forceps 

2. Pipette 500uL of diluted EtOH onto the flug being careful not to drip EtOH onto 

the edges of the vial. 

3. Flip flies from each vial into individual vials with flugs for one set of flies. Cover 

each vial quickly with an orange cap so that no flies escape.  

4. Place the capped vials into the rig with the orange cap on the bottom. Carefully 

place the top of the rig so that the vials fit securely in the grooves. 

5. Place a label on the right panel of the rig describing the genotype, the test (i.e. 

EtOH), and date. 

6. Rap the rig three times on the table and start the timer after 3rd rap. 

7. When the timer reaches 3 seconds, press the shutter button on the camera to 

take the picture 

8. Wait until the timer reaches 1 minute and rap the rig against the table 3 times. 

9. When the timer reaches 1 minute 6 seconds, press the shutter button on the 

camera to take the picture 
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10. Repeat steps 9 and 10 for each minute thereafter. Continue until over ½ of the 

flies climb only ½ way up the vial in each vial or until the 20th repetition. 

11.  Flip flies back into their vials. At this point the testing is done for this set of flies. 

You may either throw out these flies or keep them for other types of testing. 

12. Repeat the above steps for each set of flies being tested. 

 

Clean-Up 

1. Remove flugs from vials and throw out the flugs. Place vials and orange caps 

into a gray bin beside the sink in the fly room to be cleaned. 

2. Turn off light source, camera and humidifier 

3. Make sure rig is put away and everything is in order 

4. Turn off light and close and lock door to testing room when done. 

 

Data Analysis and Processing 

Photo Processing 

1. Put memory card into card reader and plug card reader into the computer. Copy 

pictures from card into a folder on your desktop. 

2. Open Adobe Photoshop 5.0 

3. In Photoshop open pictures you wish to edit. (NOTE: Photoshop has an upper 

limit of the number of pictures that can be opened at a time. 18 pictures is usually 

a good number to work with at a time) 

4. On the right hand side of the screen a menu should be present in the menu press 

the “Create New Action” button.  This will cause a screen to appear asking you to 
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name and change certain settings. You can name the action if you wish 

otherwise press “Record” to continue. 

5. Use the marquee tool to draw an outline around the vials and the panel with the 

label. In the Image menu in the toolbar select crop. 

6. In the Image menu in the toolbar select Mode, then select grayscale. It will ask if 

you wish to discard color information, press ok to continue. 

7. In the Image menu in the toolbar select Image Size. This will come up with a 

screen where you can adjust the picture.  Change image height to 3 inches.  This 

will automatically adjust the width. Press ok to continue. 

8. In the File menu in the toolbar select Save As.  Save a copy of the picture in TIFF 

format to the folder you created on your desktop. 

9. Close the picture that was being edited. 

10. Press the stop button on the right hand menu to stop the recording 

11. Press play for each picture, this will do all of the above steps in editing the 

picture. 

12. Continue for all the pictures for the experiment. 

13. Close Photoshop and open Scion image. 

14. In Scion Image open options in the Analyze menu in the toolbar. Make sure that 

only X&Y Center is checked, the max measurement is set to 8000, the field width 

is 9 and the digits to the right of decimal point are 5. In the Options menu select 

preferences and make sure the ClipBoard Buffer Size is set 99999 and the boxes 

for Invert Y-axis and Desktop Friendly are checked. If these are not the defaults 
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then change them, and in the file menu select record preferences to make these 

the default choices. 

15. In the toolbar open the Special Menu.  In the Special menu select Load Macros. 

16. In the Macros folder select the ScreenMacros 

17. Open TIFF formatted pictures in the file menu (NOTE: It might be easier to start 

off with only 3 or 4 pictures) 

18. Once the pictures are open, select Subtract Background from the Special Menu 

19. Select Threshold in the Special Menu. All pictures that are opened in Scion 

Image will be edited when Subtract Background and Threshold are executed. It is 

therefore unnecessary to repeat this process for each picture open. 

20. Choose the eraser tool and erase anything in the picture that is not a fly. 

21. Choose the pencil tool and make the “ink” white.  Draw lines to separate any flies 

that look to be joined in the picture. 

22. In the Analyze menu select Analyze Particles. In the screen that pops up make 

sure minimum particle size is set to 3 and max is set to 50.  Make sure the 

options for Label Particles and Reset Measurement Counter are selected only. 

23. The picture will now have numbers where the flies are. Click on the picture and 

press Ctrl-C to copy these values. 

24. Paste the values into a blank excel sheet labeling each set of values for 

reference. 

25. Repeat this for each picture. 
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Analysis 

Analysis needs to be done in sets based on genotype and EtOH concentration. 

1. Open the Excel file named “eRING Reduction MASTER 2007”.  In this file 

change the date to correspond with the date tested.  For each set you will also 

need to change the genotype, EtOH concentration and Time depending on the 

picture. 

2. Open the Excel file named “eRING Compiled”. Nothing needs to be changed in 

this file. 

3. In the “eRING Reduction MASTER 2007” paste the values for the first picture of 

the set. Change any information regarding the genotype, EtOH and time as 

necessary.  For the first picture of the set the time should be set to 0. For each 

picture after this in the set increment time by one (i.e. Time 0 would be the first 

picture, Time 1 would be the second picture and so on.) 

4. In the “eRING Reduction MASTER 2007” once the values are pasted in the left 

hand side of the sheet, press Ctrl-Shift-E. This will run the Macros for the two 

Excel sheets. 

5. Save the “eRING Reduction MASTER 2007” by selecting Save As from the File 

menu and save it accordingly. Close the “eRING Reduction MASTER 2007” file. 

DO NOT save the “eRING Compiled” file at this time. 

6. Open a new “eRING Reduction MASTER 2007” file and change the date, 

genotype, EtOH concentration and time to correspond to the second picture of 

the set.  
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7. Repeat steps 3-5 for each picture in the set.  For water there will only be 3 value 

sets to analyze for each genotype. For EtOH there will be more than three value 

sets. Once the mean reaches below 0.5 in the “eRING Compiled” file you do not 

need to analyze any further pictures for that set. 

8. Once the set is complete save the “eRING Compiled” file by selecting Save As 

from the File menu and save it accordingly. 

9. Repeat this process for each set. 

 

Data Processing and Clean-Up 

1. In the water “eRING Compiled” files, copy the individual vial values from the 

tab labeled “Individual Vial T50s”. Paste these values into a new excel sheet 

and average the values for each vial. 

2. In the “eRING Compiled” files for EtOH, create a copy of the “Individual Vial 

T50s” sheet by right clicking the tab and selecting Create Copy and Move to 

End from the window that pops up. 

3. In the copied sheet on the right hand side, copy the values for each vial and 

paste them at one time point lower. At time point 0 paste the average water 

values for that genotype by copying those values and right clicking and 

selecting Paste Special. A window will pop-up, select values and press OK. 

4. Looking at the graph, delete values for each vial where the values seem to 

level off. 

5. Copy these values and paste them into a PRISM file to create a line graph.  
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6. Copy the T50 values from the copied and now modified “Individual Vial T50s” 

into PRISM to make a bar graph. Each graph (line and bar) should contain the 

mutant values and the control w[A] values. 
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F. Internal Ethanol Content 

Ethanol Content Protocol 

**Use pre-chilled solutions throughout assay for consistency** 

 

1.  Grow/collect flies and prepare Flugged vials as you normally would for eRING 

assays.  Use 25 flies/vial and typically 1 vial/genotype with 3-5 vials total per test.  

Expose one group to ddH2O (0 minutes) and other groups to ethanol (0.5 ml in Flug) 

during eRING tests for 5 and 10 minutes or other times as appropriate. 

2.  After each water or ethanol exposure, transfer flies to labeled 1.5 ml snap-cap tubes 

and store at -20°C.  Continue water and ethanol exposures until you have a complete 

set of frozen flies from each genotype at each time-point. 

3.  Homogenize frozen flies with drill/pestle in 200 µl ice-cold ddH2O for 30 seconds.  

Keep flies on ice before and after homogenization. 

4.  Centrifuge homogenized flies at maximum speed at 4°C for 20 minutes.  Prepare 25 

mM standard by adding 4.37 µl of 100% ethanol to 2996 µl ice-cold ddH2O.  Prepare 

remaining standards using the table below.  Store standards on ice. 

5.  Transfer 100 µl of clear supernatant to new labeled 1.5 ml snap-cap tube.  Lipid or 

other crud will stick to the outside of the pipette tip.  DO NOT TOUCH PIPPETTE TIP 

TO NEW TUBE!  Store 100 µl supernatants on ice. 

6.  Add 300 µl of cold ethanol reagent to 1.5 ml snap-cap tubes for each sample (in 

triplicate, 3 tubes/sample) and standard (in duplicate, 2 tubes/standard). 
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7.  Add 10 µl of each sample supernatant and standard to the corresponding tube from 

step 6.  Mix by single pulse vortexing. 

8.  Incubate at 30°C in heat block for 5 minutes. 

9.  Read absorbance of 100 µl of each reaction at 340 nm and interpolate values for 

samples in Prism. 

10.  Final ethanol concentration in samples determined as:  mM interpolation x(3/10)x 

(200 µl/[# flies x µl/fly]).  Fly volume in µl is determined as indicated on next page.  Each 

vial of flies is an N of one. 

 

Notes: 
1.  Standards 
Standard Volume of ddH2O Volume of 25 mM 

0 mM 1000 µl 0 
5 mM 800 µl 200 µl 
10 mM 600 µl 400 µl 
15 mM 400 µl 600 µl 
20 mM 200 µl 800 µl 

   
25 mM 2996 µl 4.37 µl (100% ethanol, 17.16 M) 

 
2.  Alcohol Reagent:  Dilute per manufacturer’s instructions.  Good for at least 2 weeks 
at 4°C. 
3.  Reaction is maximal at ~2 minutes and has a stable product (i.e. A340) out to at 
least 12 minutes. 
4.  Use all cold reagents for consistency. 
5.  A 10 minute exposure to vapor from 50% ethanol in an eRING assay should lead to 
a final internal ethanol concentration of ~150 mM in control flies.  Each vial of flies is an 
N of one. 
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Fly Volume Protocol 

1.  Grow/collect flies as you normally would for eRING assays.  Use 25 flies/vial and 

typically 3 vials/genotype.  Each vial of flies is an N of one. 

2.  Drill 2-3 holes in the lids of 1.5 ml snap-cap tubes (one tube for each vial of flies in 

step 1) using a flame-heated needle (~20 gauge, large enough for CO2 to enter but 

small enough to retain flies).  Be careful! 

3.  Weigh each 1.5 ml snap-cap tube from step 2 using the Mettler PB153S balance and 

record the tube weight out to 3 decimal places on the side of each tube or elsewhere.  

This is the tube weight. 

4.  Anesthetize flies in vials and transfer to weighed tubes from step 3.  Place tubes 

upside down on CO2 plate in quarantine area to keep the flies anesthetized. 

5.  Weigh each tube containing flies from step 4 using the same balance and record the 

weight out to 3 decimal places on the side of each tube or elsewhere.  This is the tube 

wet weight. 

6.  Place the tubes with flies in a 55°C dry incubator for 18-24 hours to desiccate. 

7.  Weigh each tube containing desiccated flies from step 6 using the same balance and 

record the weight out to 3 decimal places on the side of each tube or elsewhere.  This is 

the tube dry weight. 

8.  Determine the total weight of each fly:  ([tube wet weight] – [tube weight])/# flies.  

This should be ~1.5 mg/fly.  Females will be bigger than males. 

9.  Determine the water weight of each fly:  ([tube wet weight] – [tube dry weight])/# 

flies.  This should be ~0.8 mg/female and 0.6 mg/male. 
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10.  One mg of water weight = one µl of water volume.  The water volume is used to 

calculate the internal ethanol concentration (see previous page). 

 

Citations:   

Moore, M. S., J. DeZazzo, A. Y. Luk, T. Tully, C. M. Singh and U. Heberlein (1998). 

"Ethanol intoxication in Drosophila: Genetic and pharmacological evidence for 

regulation by the cAMP signaling pathway." Cell 93(6): 997-1007.  

Bhandari, P., J. C. Bettinger, A. G. Davies, K. Kendler and M. Grotewiel (2009). "An 

assay for evoked locomotor behavior in Drosophila reveals a role for integrins in ethanol 

sensitivity and rapid tolerance." Alcohol Clin Exp Res 33(10): 1794-805. 
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G. Sequencing Sample Preparation 

PCR samples with sequencing primers using 200ng of gDNA. 

Take 5ul of each sample and add it to 2ul of ExoSap-IT 

Run samples on the following Thermal Cycler Protocol: 

 37C for 30min 

80C for 15min 

4C for ever 

  

Add 2ul of forward primer, and 1ul of water to ExoSap cleaned PCR products. 

Use the Low Cost method of primer extension sequencing at ACGT Inc. 
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